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Warning !

1. Battery
Battery on board is consumables. We doesn’t guarantee the life time of it.

2. Fanless solution with HDD
Please be aware of specification & limitation for HDD when fanless solution
is implemented.

3. We will not give further notification if there is any change about the product
information and the manual.

4. SATA does not support Hot SWAP.
5. There would be t 20% difference of WDT at room temperature.

6. Please make sure the voltage specification meet the requirement
of the equipment before plugging into the power.

7. SSD has 2 types, commercial grade and industrial grade, which provide
different read/write speed, operation temperature and life cycle.
Please contact sales for further information before ordering.

8. Caution ! Please notice that the heat dissipation problem could cause the
MB system unstable. Please handle the heat dissipation properly when
buying single MB.

9. Please avoid to approach the heat sink area and prevent being scalded when
using the Fanless products.

10. If the users repair, modify or destroy any component of product
unauthorized, We would not take responsibility or provide warranty.

11. DO NOT apply any other material onto the thermal pad in case reducing
cooling performance.

12. It is important to install a System Fan toward the CPU to prevent the
possibility of overheating / system hang up issues from Cedar view-D series
of motherboard or else customer is required to have well cooling system to
dissipate heat from CPU.




>k Hardware Notice Guide

1. Before installing the power supply with this motherboard, please attach the 12V/DC
(2 pin connector )of the adapter to motherboard first.
After that, plug the adapter power to AC outlet.
Always normally shut down the computer before you move the system unit or remove
the power supply from the motherboard.
Please unplug the 12V/DC ( 2 pin connector ) of the adapter from motherboard first.
Then unplug the adapter from the AC outlet.
Please refer to procedure from the photo 1

2. There will be high possibility to burn out the CPU if you change/ modify any parts of the
CPU cooler.

3. Please wear wrist strap and attach it to a metal part of the system unit before handling a
component.
You can also touch an object that is of ground connection or with metal surface if you don't
have wrist strap.

4. Please be careful when you handle this product. Pay attention to & don't touch the
sharp-pointed components at the bottom PCB .

5. Please pay attention to this: Remove or change any components form the motherboard
will VOID the warranty of the motherboard you purchased .

6. Before you install/remove any components or make any jumper setting on the motherboard,
please make sure to disconnect the power first.
( Please follow the instructions as of this guide )

7. Please only use single side Mini PCle card, do not use the double side Mini PCle card
which is not suitable.

8. Please follow this instruction carefully when using the "POWERON after PWR-Fair" function.
When the DC power adaptor runs out of power, unplug it from the DC current;
when power returns plug it back in only after 5 seconds. If there is a power outage,
unplug it from the AC current, when power returns plug it back in only after 30 seconds.
Otherwise it will cause system locking or serious damage.

Remark 1:

Always insert/unplug the 12V/DC ( 2 pin connector ) horizontally & directly from the
motherboard.

DO NOT twist the 12V/DC ( 2 pin connector ) gently, it is designed to fit snugly .
Moreover, erratic pull / push testing with the DC Jack might cause the unpredictable
damage to the component & system unit.
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Chapter-1

General Information

The 31847AW/CW is a 3.5-inch compact embedded system board that features Intel® 1.
Mobile vy Bridge 1047UE/i3/i5/i7 Processor paired with HM76 chipset to support two super
speed USB 3.0 ports, and one DDR3 SO-DIMM memory socket up to 8GB DDR3

SDRAM/ 1600MHz.

High-performance and power-efficient communication platform, the embedded motherboard
of 31847AW/CW is specially designed for advanced embedded car PC or POS system
applications where the economical use of power is in high demand. Also, there is a sizable
on board DDR3 memory from 31847AW/CW motherboards which will provide more stability to
the system. This motherboard will ensure the high performance levels required for today's
most popular POS/Automation control applications including Embedded Car PC, POS, ATM,
Kiosk and Panel PC applications.

The 31847AW/CW integrates with Intel® HD graphics engine to support

OGL 3.0, dual displays of CRT resolution up to 1920x 1200, single/dual channel 18-/ 24- bit
LVDS (31847CW) and HDMI 1080p. Besides, 31847AW/CW has Intel LAN chipset with
10/100/1000 Mbps Ethernet for seamless broadband connectivity. With the Wake-On LAN
function and the PXE function in BIOS for Intel LAN chipset, it is perfect control board for
networking devices.

31847AW/CW also supports multiple COM ports of five RS232/485 and one RS422/485 to meet
the needs of connectivity for multiple COM ports. In addition, there are multi-ports of Hi-Speed
USB 3.0 and USB 2.0 to enhance the host controller interface which will ensure the high
performance level and flexible expansion. A single Flash chip holds the system BIOS,

and you can change the Flash BIOS by the Utility Update.

The 31847AW/CW is All-In-One board which could apply to the use of Networking,

POS or Automation Control Board. It is designed to combine all necessary input and output
affects interfaces, which makes it to be ideal All-In-One control board for the demand of
Networking, POS and Automation Control applications. 31847AW/CW is the perfect platform
for a whole range of small form factor.




1-1 Major Feature

1. Mobile Ivy Bridge 1047UE/i3/i7 Processor

2. Intel® HM76 Express Chipset

3. DDRS3 up to 8GB; data transfer rates of 1333MT/s and 1600 MT/s

4. 2 xIntel® Giga LAN

5. On board SSD 2/4/8/16/32/64 GBytes (Option)

6. Support expanded PCle Mini card for PCle x1 and USB interface,
PCle Mini card for PCle x1 or mSATA and USB interface

7. Support up to 4 SATA ports

8. Hardware digital Input & Output, 8 x DI / 8 x DO
Hardware Watch Dog Timer, 0~255 sec programmable

9. On board DC +12V

10. PCB Dimension: 146 x 102 mm

11. Up to 2 SIM card sockets

12. 31847C: USB /COM interface Touch screen controller, support 4- , 5- , 8- wire Analog

Resistive touch screen. Resolution is up to 2048 x 2048




1-2 Specification

1.

CPU+Chipset: 1. Intel Chief River platform; the two-chip platform consists of a Mobile
Ivy Bridge 1047UE/i3/i5/i7 Processor and the Platform Controller Hub (PCH)

Panther Point HM76 chipset

Memory: Single Channel DDR3 SODRAM 204pin, Max. 8GB,

DDR3 data transfer rates of 1600 MT/s

3. VGA: Intel Mobile Ivy Bridge 1047UE Processor Integrated Graphics

© © N o v

1.

12.
13.
14.
15.
16.
17.
18.

SATA: Integrated Serial ATA Host Controller Up to 4 SATA ports: 1 SATA port 3.0 Data
transfer rates up to 6.0 Gb/s (600 MB/s), 1 SATA ports 2.0 Data transfer rates up to 3.0
Gb/s (300 MB/s), 1 mini card socket for mSATA Data transfer rates up to 6.0 Gb/s
(600 MB/s), 1 on board NAND drive (Option)

LAN: Intel 82579LM Gigabit Ethernet PHY & Intel 82574L PCle LAN NIC

Serial Port: 5 x RS232 (Internal); 1 x 422/485 (Internal)

USB: 2 x USB 3.0 (external) on board; 2 x USB 2.0 on board; 5 x USB 2.0 (internal)
Sound: Intel High Definition Audio Interface

Audio Amplifier: 2 channel Class D Audio Amplifier; 2.57W/Ch (Typ.) into a 4QLoad,
1.46 W/Ch (Typ.) into a 8QLoad

. WDT/DIO: Hardware digital Input & Output, 8 x DI / 4 x DO (Option)

Hardware Watch Dog Timer, 0~255 sec programmable (Option)

Expansion interface: 1 PCle Mini card for PCle x1 and USB interface,

1 PCle Mini card for PCle x1 or mSATA and USB interface, up to 2 SIM card sockets
(1 socket is optional and share on board SSD).

B1OS: AMI UEFI BIOS

Dimension: 145 x 102 mm

Power: On board DC +12V

Power Consumption: Please refer to Page. 84

3G Wireless: 3G SIM card reader

LVDS: 1 LVDS 2x15 pin (1.25mm) connector for 24bits/2ch LVDS interface

Touch function: 31847C: USB /COM interface Touch screen controller,

support 4- , 5-, 8- wire Analog Resistive touch screen. Resolution is up to 2048 x 2048




1-3 Installing the SO-DIMM

1. Align the SO-DIMM with the connector at a 45 degree angle.




Notices:
1.The connectors are designed to ensure the correct insertion. If you feel resistance,
check the connectors & golden finger direction, and realign the card.

2. Make sure the retaining clips (on two sides of the slot) lock onto the notches of
the card firmly.




1-3-1.1 Removing the SO-DIMM

1. Release the SO-DIMM by pulling outward the two retaining clips and the SO-DIMM
pops up slightly.

iR




1-4 Directions for installing the Mini Card

1. Unscrew the screw on the board 2. Plug in the Mini Card in a 45°angle

3. Gently push down the Mini Card and screw the screw back.
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1-5 Packing List ( 31847AW / CW)

Material Code Description Detail Specification Quantit
1 | 7G1901-1353001-0 | MB-3I1847A-3C4-00-001 LF3I1847A-3C4-00,Rev.:001 1
2 | 6G8006-2344-0100 | DVD LFIntel Cedarview-M/D,Sandy Bridge 1
3 | 6G6001-2203-0100 | SATA DATA Cable (Red) LEL=25cm 2
4 | 6G6001-2005-0100 | COM FK LF2.0 2*5P/DB9P,L=15cm 5
5 | 6G6002-8006-0100 | USB RK,(USB*1 to 1*4/1.25 Housing) | LFL=20cm,Intel 4
6 | 6G8001-2180-0400 | Manual LFEM/B,3I1847AWICW 1
7 | 6G5212-0804-0100 | 84W Power Adapter,12V/7A LEL Type,FSP084-DMBA1,FSP 1
8 | 6G6003-7310-0100 | DC PK LF2.0 1*4/M4P M/FL=15/5.5cm 1
9 | 6G6003-1003-0100 | SATA Power Cable,1to2 LFL=15cm,SATA Power*2/4P 1
10 | 6G6002-8603-0100 | PS/2 RK LFKB&Mouse Cable,L.=10cm 1
11 | 6G6001-8404-0100 | VGAFK LFL=15cm,2.0 2*5/DB15pin 1

*The packing list above is for the users who purchase single motherboard. The users

who purchase the board with chassis may refer to the packing list in the Assembly Guide.

Please contact with your dealer if any of these items is missing or damaged
on delivery. And please keep all parts of the delivery package with packing
materials in case if you need to deliver or store the product in the future.
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Chapter-2

Hardware Installation

This chapter provides the information how to install the hardware of 31847AW/CW.
Please follow section 1-6, 2-1 and 2-2 to check the delivery package and unpack
carefully. Please follow the jumper setting procedure.

2-1 Unpacking Precaution

The 31847AW/CW board has been well packed with

an anti-static bag to protect its sensitive components and circuitry from damage due to
static electric discharge.

NOTE!
1. Do not touch the board or any other sensitive components without all necessary
anti-static protection.
2. Please pay attention to the voltage limitation of DC-IN12 V 5 %.
Overuse of DC-IN voltage limitation or change to another power adapter
( not provided with this system ) will VOID warranty.

You should follow these

steps to protect the board from the static electric

discharge whenever you handle the board:

1. Ground yourself by a grounded wrist strap at all times when you
handle the 31847AW/CW.
Well secure the ALLIGATOR clip of the strap to the end of the shielded wire lead from
a grounded object. Please put on and connect the strap before handling the
31847AW/CW for harmlessly discharge any static electricity
through the strap.

2. Please use anti-static pad to put any components, parts, or tools on the pad whenever
you work on them outside the computer. You may also use the anti-static bag instead of

the pad. Please ask your local supplier for necessary parts on anti-static requirement.

3. Do not plug any connector or set any jumper when the power is on.

12



2-2 Unpacking checkup

First of all, please follow all necessary steps of section 2-1 to protect 31847AW/CW
from electricity discharge. With reference to section 1-6 / 1-7 / 1-8,
please check the delivery package again with following steps:

1. Unpack the 31847AW/CW board and keep all
packing material, manual and driver disc etc, do not dispose !

2. Is there any components lose or drops from the board?
DO NOT CONTINUE TO INSTALL THIS BOARD!
CONTACT THE DEALER YOU PURCHASED
THIS BOARD FROM, IMMEDIATELY.

3. Is there any visible damage on the board?
DO NOT CONTINUE TO INSTALL THIS BOARD!CONTACT
THE DEALER YOU PURCHASED THIS BOARD FROM, IMMEDIATELY.

4. Check your optional parts (i.e. DDR, CF etc.), all necessary jumpers
setting to jumper pin-set, and CMOS setup correctly.
Please also refer to all information of jumper settings in this manual.

5. Check your external devices (i.e. Add-On-Card, Driver Type etc.)
for complete add-in or connection and CMOS setup correctly.
Please also refer to all information of connector connection in this manual.

6. Please keep all necessary manual and driver disc in a good condition for future
re-installation if you change your Operating System.

13



2-3 Dimension 145 x102 mm (3.5 inch)- 31847AW/CW
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2-4 Layout - 31847AW / CW
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2-5 Diagram- 3I1847AW
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2-5-1 Diagram- 31847CW
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2-5-2 Bottom Side Diagram- 31847A / 31847C

COH1 COos1

CuUs

CuU6

SATA1 SATA2

Back Panel-31847A / 31847C

LAN1L Mic-In HDMI

LAN2
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2-5-3 Bottom Side Diagram- 3I1847AW / CW

COH1 COos1

CuUs

CuU6

SATA1 SATA2

Back Panel-31847AW / CW

LAN1L Mic-In HDMI

LAN2
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2-6 Install Memory

This motherboard provides one 204-pin Small Outline Dual In-line Memory Module (SODIMM)
socket for memory expansion available maximum to of 2GB/4GB/8GB DDR3 SDRAM.
DDR3 clock supports: DDR3 1333/1600MT/S

Valid Memory Configurations

Total Memory
DIMM1 System Accept or Not
Max.
DS/SS Accept 8GB
DS: Double Sided DIMM SS: Single Sided DIMM
NOTE!

The detected memory size is less than actual installed memory size since
some memory has been allocated for system use.
That’s how PC works with system memory.

Please refer to page 9 for installation of memory module.

20



NOTE!

When you install SODIMM module fully into the SODIMM socket,
the eject tab should be locked into the SODIMM module
very firmly and fit into its indention on both sides.

WARNING!

Once you hear " Beep Beep Beep" sounds after turning on the power ,
please check if the DRAM is installed properly or not.

2-7 List of Jumpers

JSB1 : CMOS clear select

JSB2 : ME RTC clear select

JSC2 : COM2 RS422/RS485 select
JSD1 : DPC Duty select

JVC1 : COM1 voltage select

JVC3 : COM3 voltage select

JVL1 : LCD Panel power select

JVP1 : LVDS Panel Inverter power select
JVU9 : USB9 voltage select

21



2-8 Jumper Setting Description

A jumper is ON as a closed circuit with a plastic cap covering two pins. A jumper is OFF
as an open circuit without the plastic cap. Some jumpers have three pins, labeled 1, 2,
and 3. You could connect either pin 1 and 2 or 2 and 3.

The below figure 2.2 shows the examples of different jumper settings in this manual.

El Figure 2.2

ON OFF
[T e =9
1-2 2-3

All jumpers already have its default setting with the plastic cap inserted as ON,

or without the plastic cap as OFF. The default setting may be referred in this
manual with a " " symbol .

2-9 CMOS Data Clear

A battery must be used to retain the motherboard configuration in CMOS RAM.
Close Pinl and pin 2 of JSB1 to store the CMOS data.

To clear the CMOS, follow the procedures below:

1. Turn off the system and unplug teh AC power

2. Remove DC 12V power cable from DC 12V power connector

3. Locate JSB1 and close pin 1-2 for few seconds

4. Return to default setting by openning pin 1-2

5. Connect DC 12V power cable back to DC 12V Power connector

22



JSB1: CMOS Data Clear Note: Do not clear CMOS unless

1. Troubleshooting

JSB1 Description 2. Forget password
3. You fail over-clocking system

*open Normal Set
short CMOS Data clear

Note : Normal work is open jumper

JSB1
21 21
-
*Normal Clear Setting

2-10JSB2 : ME RTC Data clear

A battery must be used to retain the motherboard configuration in ME RAM.
Close Pinl and pin 2 of JSB2 to store the ME data.

To clear the ME,follow the procedures below:

. Turn off the system and unplug teh AC power

. Remove DC 12V power cable from DC 12V power connector

. Locate BAT1 and Remove Li battery

. Locate JSB2 and close pin 1-2 for few seconds

. Return to default setting by openning pin 1-2

. Install Li battery to BAT1 connector

. Connect DC 12V power cable back to DC 12V Power connector

~NOoO b~ WNPRE

JSB2 Description Note: Do not clear CMOS unless
*open Normal set 1. Troubleshooting

short CMOS data clear 2. Forget password
3. You fail over-clocking system

Note : Normal work is open jumper

JSB2
21 21
*Normal Clear Setting

23



2-11 JSC2 : COM2 RS422/RS485 select

JSC2 DESCRIPION
*1-2 RS422
3-4 RS485

Note : RS422/485 setting by both H/W jumper and BIOS CMOS setting

JSC2
— B /B
*RS422 RS485

2-12 JSD1 : DPC Duty set

JSD1 | DESCRIPION
1-2 [ Low 0% (Low level)
*2-3 | Hi 100% (3.3V level)

Note : For Panel backlight dimming default active set

JSD1
B 5
2 2
1 1
Low level *3.3V level

24



2-13 COM port pin9 select RI signal or Voltage source

JVC1 : COM1 PIN9 select

JVC3 : COM3 PIN9 select

JVC1/3 Descripion

*1-2 COM port pin9 use RI signal
3-4 COM port pin9 use +5V voltage
5-6 COM port pin9 use +12V voltage

Note : 1. Note : Attention ! Check Device Power in spec
2. If want to use +5V/+12V need check system power design spec

246 246 246
O O o o [eNe]

L - Jgvc1 [§99 °Rs °<H
135 135 135

i [=le] 1{ool2 1fool2

JVC3 3|oofa k] [exe] P 3loofa

50 0|6 5|0 Q6 5[0 0|6

*RI signal +5V +12V

2-14 JVL1 : LCD panel power select

JvL1 Descripion
1-2 +5V
*2-3 +3.3V

Note : Attention ! Check Device Power in spec

JviLl

3
2
1

+5V

3
2
1

*+3.3V
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2-15 JVP1 : LVDS panel Inverter power select

JVP1 Descripion
1-2 +12V
*2-3 +5V

Note : Attention ! Check Device Power in spec

JVP1

3
2
1

+12v

2-16 JVU9 : USB Port 9 Voltage select

Jvu9 Descripion
*1-2 +5V

2-3 +3.3V
Note : Attention ! Check Device Power in spec

JVvu9

*+5V

3
2
1

*+5V

-
IN]
w

+3.3V
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Chapter-3

Connection
This chapter provides all necessary information of the peripheral's connections,
switches and indicators. Always power off the board before you install the peripherals.

3-1 List of Connectors

CPI11 : DC-in internal connector (2x2pin 4.2mm ATX connector)
CPI12 : DC-in 1x4 pin (2.0mm) Red wafer connector

CPI13 : DC-in 1x5 pin (2.0mm) wafer connector ( Option )
BAT1 : Li 3V battery holder

CPOL1 : DC +5/+12V output 1x4 pin(2.0mm) Black wafer connector
CFP1 : Front panel port 2x5 pin (2.00mm) wafer

SWP1 : Power On/Off switch wafer

FAN1 : CPU fan 1x3 pin (2.54mm) wafer

CG1 : VGA port 2x5 pin (2.0mm) wafer

DVI1 : DVI-D connector

HDMI1 : HDMI type A connector

LVDS1 : LVDS 2x15 pin (1.25mm) connector

CPP1 : Panel inverter power connector 1x5 pin (2.0mm) wafer
CT1 : Touch screen device 2x5 pin (2.0mm) Wafer

CA11 : Line out phone jack

CA12 : Mic-in phone jack

CAL1 : Amplifier Line-out Left channel 2pin (2.0mm) wafer
CARL1 : Amplifier Line-out Right channel 2pin (2.0mm) wafer
CC1/CC2/CC3/CC4/CC5/CC6 : COM 2x5pin (2.0mm) wafer
CIO1 : Dl port 0 ~ 3, DO port 0 ~ 3 2x5 pin (2.0mm) wafer
CIO2 : Dl port 4 ~ 7, DO port 4 ~ 7 2x5 pin (2.0mm) wafer
COL1 : I°C 4pin (1.25mm) wafer

CKM1 : KB/MS port 1x6 pin (1.25mm) wafer connector
CL1/CL2 : LAN RJ45 connector

CU5/CUG6 : USB port 4/5 Type A connector
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List of Connectors

CU1/CU2/CU7/CU8/CU9 : USB port 0/1/12/11/13 4pin(1.25mm) wafer
CU12 : Dual USB USB3.0/2.0 connector

SATAL : SATA port 0 (Gen 1) connectors 7pin

SATA2 : SATA port 2 (Gen Il) connectors 7pin

MPCE1/MPCEZ2 : Mini card port 1/2 sockets 52pin

SIM1 : SIM port 1 card socket

SODIM1 : SO-DIM DDR3 1.5V DRAM Socket
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3-2 FAN Connector
e FAN1 : CPU FAN connector (3pin 2.5mm wafer)

PIN NO. Description
1 GND
2 +12V
3 FAN speed detect

Note : DC in +12V by switch to FAN power +12V,
so DC in need stable +12V input

3-3 VGA port Connector co1
0O 0O0O0O0

e CG1 : VGA wafer (2x5pin 2.0mm wafer ) ocooomO
PIN NO.| Description PIN NO. Description pint

1 BULE 2 GND

3 GND 4 DDC CLOCK

5 GREEN 6 V-SYNC

7 GND 8 H-SYNC

9 RED 10 DDC DATA

3-4 Front Panel connector

CFP1 pinl

e CFP1 Front panel connector (2x5pin 2.00mm wafer) SWPl
PIN NO. | Description PIN NO. | Description pinl

1 Power button pin 2 Power button GND

3 Reset pin 4 Reset GND

5 Power LED - 6 Power LED +

7 HDD LED- 8 HDD LED+

9 LAN LED- 10 LAN LED+

e SWP1 PB connector (2pin 2.0mm wafer)

PIN NO.| Description
1 Power button pin
2 Power button GND

29



3-5 PS2 KB/MS

o CKM1 : KB/MS port 1x6pin (1.25mm) Wafer

PIN NO. 1 2 3 4 5 6
Description +5V KB/DAT | KB/CLK GND MS/DAT | MS/CLK

pinl CKM1

0OO0O0O0 O O|-——-71

3-6 USB Interface
e CU5/CU6 : USBA4/5 ports (USB Type A connector )

PIN NO. Description
1 +5V
2 USB DATA -
3 USB DATA +
4 GND

Note : 1. Attention ! Check Device Power in spec

e CU1/CU2/CU7/CUS :
USB 0/1/12/11 ports (4pin 1.25mm Wafer)

PIN NO. Description

1 +5V pinl cus pinl cur
pinl ||:|ooo|||:]ooo

2 USB DATA -
0oo0o

3 USB DATA + cus[2° 2 °JF5o cu1

O00O0O0
4 GND Ccu2

Note : 1. Attention ! Check Device Power in spec

e CU9 : USB13 port (4pin 1.25mm Wafer)

PIN NO. Description
1 +5V or +3.3V
2 USB DATA -
3 USB DATA +
4 GND

Note : 1. PIN 1 Voltage select from JVU9
2. Attention ! Check Device Power in spec
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e CU12 : Dual USB3.0/2.0 port (Type A jack)

PIN NO.| Description PIN NO.] Description

1 USB3.0 TX+

1 +5V

2 USB 2.0 D- 2 USB3.0 TX-
3 GND

3 USB 2.0 D+ 4 USB3.0 RX+

4 GND
5 USB3.0 RX-

Note : 1. USB 3.0 and USB 2.0 combo Type A Jack
2. USB3.0/2.0 Keyboard and Mouse use CU12 can pitch Some OS install
And wake up Keyboard and Mouse can’t work issue

3-7 LAN Interface
e CL1/CL2: LAN Giga/100Mb (RJ45 Jack)

PIN NO | Description PIN NO.| Description
1 TRO-/TX+ 5 TR2-/INC
2 TRO+/TX- 6 TR2+/RX-
3 TR1-/RX+ 7 TR3-/INC
4 TR1+/NC 8 TR3+/NC

e RJ45 LAN Connector--- LED define Giga/100MB Connector

Back side con RED LED GREEN LED YELLOW LED
Indicate GIGA LAN 100Mb LAN Active LED
Link(light) Link(light) Link(Blink)
LAN LED
Intel 82574L / 82579LM
Speed 10 Mbps 100 Mbps 1000 Mbps
Back Side Fornt Side Back Side Fornt Side Back Side Fornt Side
Indicate
Link Led | ACT Led | ACT Led | Link Led| ACT Led | ACT Led | Link Led| ACT Led | ACT Led
LAN light Orange | Orange Green | Orange Orange Red Orange | Orange
cL2 CL1
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3-8 1/0 Interface

e COM ports (COM1~COMS6 from support /O )
COM1/3/4/5/6 default support RS232 mode
COM2 default support RS422/RS485 mode

e RS232 mode ports (2x5pin 2.0mm Wafer)

CCl:COM1 CC2:COM2
CC3:COM3 CcC4:COM4
CC5: COM5 CC6 : COM6

PIN NO. | Description PIN NO. Description
1 DCD 2 RXD
3 TXD 4 DTR
5 GND 6 DSR
7 RTS 8 CTS
9 RI/VOLTAGE 10 +5V

Note : 1. CC2 connector RS232 function for OEM BOM request

2. The Pin 9 Voltage set by JVC1/3 for CC1/CC3

o RS485 mode ports (2x5pin 2.0mm Wafer)
CCl:COM1 CcC2:COM2
CC3:COM3 CC4:COM4
CC5: COM5 CC6: COM6

PIN NO. | Description PIN NO. Description
1 RS485 TX- 2 RS485 TX+
3 NC 4 NC

5 GND 6 NC

7 NC 8 NC

9 NC 10 +5V

Note : 1. CC1 ~ CC3 ~ CC4 ~ CC5 ~ CC6 connector RS485 function for OEM BOM request

2. BIOS need setting to RS485 mode

e RS422 mode ports (2x5pin 2.0mm Wafer)
CC1:COM1 CC2:COM2

PIN NO. | Description PIN NO. Description
1 RS422 TX- 2 RS422 TX+
3 RS422 RX+ 4 RS422 RX-
5 GND 6 NC
7 NC 8 NC
9 NC 10 +5V

Note : 1. CC1 connector RS422 function for OEM BOM request

2. BIOS need setting to RS485 mode

pinl

Ogoooo

pinl 00000
Ooooo
Ccc1l60000

0000000000
ooooQgjoooonO

00000
oooonO

00000
oooonO

pinl

CC6
pinl

CC5
pinl

CC4
pinl

CC3
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3-9 I°C Bus Interface

e COL1: IZC(SM) bus connector (4 pin 1.25mm wafer)

PIN NO. 1 2 3 4
Description +3.3V GND SMB_CLK | SMB_DATA

pinl

3-10 Audio interface

The 31847A/ 31847C has an on-board AC'97 3D sound interface.
There are the connectors of LINE OUT, MIC-IN connectors.

The MIC-IN Jack header are for audio sound input. The LINE-OUT
connector is a 4-pin Jack for audio sound output.

e CAL: Line out (3.5mm phone jack)

PIN NO. 1 2 3 4 5
Description GND Line OUT-L NC NC Line OUT-R

e CA2: Mic in (3.5mm phone jack)

PIN NO. 1 2 3 4 5
Description GND MIC-IN GND NC MIC-IN

e Audio Amplifier class D Two channel
2.57W/Ch (Typ.) into a 4QLoad
1.46 W/Ch (Typ.) into a 8QLoad

o CARL1 : Audio Amplifier Line Out Right
(2pin 2.0mm wafer)

PIN NO. | Description
pinl

1 LINE-OUT R+ CARI
2 LINE-OUT_R- CAL1 pinl

e CAL1 : Audio Amplifier Line Out Left
(2pin 2.0mm wafer)

PIN NO. | Description
1 LINE-OUT_L+
2 LINE-OUT _L-

i
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3-11 Digital Input / Output / Watch Dog Time

e CIO1 DIO 0 ~ 3 (2x5pin 2.0mm wafer)

PIN NO.| Description PIN NO. Description
1 DI-0 2 DO-3

3 DI-1 4 DO-2

5 DI-2 6 DO-1

7 DI-3 8 DO-0

9 GND 10 +5V

Note : 1. DI pin default pull up 10KQ to +5V

2. If use need isolate circuit to control external device

3. F75111N-1 I’C bus address 0x9c

e ClO2 DIO 4 ~ 7 (2x5pin 2.0mm wafer)

PIN NO.| Description PIN NO. Description
1 DI-4 2 DO-7

3 DI-5 4 DO-6

5 DI-6 6 DO-5

7 DI-7 8 DO-4

9 GND 10 +5V

Note : 1. DI pin default pull up 10KQ to +5V

2. If use need isolate circuit to control external device

3. F75111N-1 I’C bus address 0x9¢c

For F75111N I'C watch dog timer device :

DC spec :

Input low Voltage (VIL) : +0.8 Max
Input High Voltage (VIH) : +2V Min

00000
oooonO

0000
oooQd

[eXe)

ClO1

Clo2

pinl

Output low Current (IOL) : 10mA (Min) VOL=0.4V

Output High Current (IOH) : -10mA (Min) VOH=2.4V

Watch Dog Time value 0~255 sec

The system will be issued reset. When WDT is enable the hardware start down counter to zero.
The reset timer have 10~20% tolerance upon the Temperature.

Note : If want to SDK support. Please contact to sales window.

34



3-11-1 10 Device:F75111 under DOS
The Sample code source you can download from

Source file: F75111_Dos_Src.rar  http://tprd.info/lexwiki/index.php/IO_Device:F75111_under_DOS
Binary file: F75111_Dos_Bin.rar
USERNAME & PASSWORD: sf

How to use this Demo Application

1.Boot Ms-Dos Operating System
2.execute "75WDT.EXE" binary file
3.Input 1 to Enable WDT timer or input O to Disable it.

4.input numbers of second for chip countdown and Reset Computer

if there's no disable signal

.

\/

[ Frsii1wor %——Enablesignal———w/
F

if there's disable signal

Disable signal

Introduction
Enable Watch Dog Timer

5 Writel2CByte(I2CADDR, CONFIG, 0x03);//Set Watch Dog Timer function E
H Writel2CByte(I2CADDR, WDT_TIMER, timer);//Set Watch Dog Timer range from 0-255. E
H Writel2CByte(I2CADDR, WDT_TIMER_CTL, 0x73);//Enable Watch Dog Timer in second and pulse mode E
F e mmmememaseseasasessssesessssessssessssessssessssssssssssssssssssssssssssssssssssss=&s=== -

void pause(int time)

asm mov ah,0h; /IAh = 00 Read System Time Counter H
asm int 1ah; //read time from Time Counter and store it in DX register H
asm add dx,time; H
asm mov bx,dx; H
label: H
asm int 1ah; H
asm cmp bx,dx; H
asm jne label; H




3-11-2 10 Device: F75111 under Windows
The Sample code source you can download from

Source file: F75111 DIOSrc.rar http://tprd.info/lexwiki/index.php/IO_Device:F75111
Binary file: F75111_DemoBin.rar
USERNAME & PASSWORD: sf

How to use this Demo Application

T FTS1Iv2AW
—Cugtormize 75111 Addres:

Input vour enstornize address © Ox

~DI0 Test

& DIDO TESTLO)

& DLDO TESTHED
7 6 5 21 0

owns: @ @ @ @ @ @ @ @

msens: @ @ @ @ @ @ @ @
st |

~WDT Test

Enable | Disable |

[~ Enable Loop

. Press the "Start" button to test DIO function

. Press the "Enable" button to test WDT function

. Press the "Disable" button to disable WDT

. Check the "Enable Loop" box and press "Enable" to do WDT loop test

ga b W N B

. Press "Install WDT" to set the system to autorun this application when booting,
press again to remove this application when booting.
6. If WDT enable, system icon will be . if disable, system icon will be n
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if there's no disable signal

3,

[ Frs1Twor %——Enablesignal———l«/
F

if there's disable signal

\/

Disable signal

p.s.
f75111 send "F75111_SetWDTEnable(BYTE byteTimer)" including a parameter "timer",

if there's no disable signal (F75111_SetWDTDisable()) to stop it before timer countdown to 0, System will reboot.
if there's disable signal received, resent Enable WDT signal, for a loop to prevent from reboot

Introduction

define GPIO1X, GPIO2X, GPIO3X to input or output
and Enable WDT function pin

DO: InterDigitalOutput(BYTE byteValue))
DI: InterDigitallnput()

Enable : F75111_SetWDTEnable (BYTE byteTimer)
Disable: F75111_SetWDTDisable ()

PULSE mode

Sample to setting GP33, 32, 31, 30 output 1mS low pulse signal.

1 5
E this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_PULSE_CONTROL, 0x00);  /IThis is setting low pulse output !
| this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_PULSE_WIDTH_CONTROL, 0x01);  //This selects the pulse width to 1mS H
E this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_CONTROL_MODE, 0x0F); [IThis is setting the GP33, 32, 31, 30 to output function. E
1 this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_Output_Data , 0xO0F); [IThis is setting the GP33, 32, 31, 30 output data. '
) |

void F75111::InitInternalF75111()

{
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO1X_CONTROL_MODE ,0x00); IIset GPIO1X to Input function
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO3X_CONTROL_MODE ,0x00); /Iset GPIO3X to Input function
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_CONTROL_MODE ,0xFF); /Iset GP102X to Output function

this->Write_Byte(F75111_INTERNAL_ADDR,F75111_CONFIGURATION, 0x03); /IEnable WDT OUT function




Set output value

BYTE byteData = 0;

byteData
byteData
byteData
byteData

BYTE F75111::InterDigitallnput()
{
BYTE byteGPIO1X = 0;
BYTE byteGPIO3X =0;
BYTE byteData  =0;

byteGPIO1X = byteGPIO1X & OXFO;
byteGPIO3X = byteGPIO3X & OXOF;

byteData
byteData

byteData
byteData

(
( byteGPIO3X & 0x08
(

return byteData;

byteData = (byteData & 0x01 )? byteValue + 0x01 :
byteData = (byteData & 0x02 )? byteValue + 0x02 :
byteData = (byteData & 0x04 )? byteValue + 0x04 :
(byteData & 0x80 )? byteValue + 0x08 :
(byteData & 0x40 )? byteValue + 0x10 :
(byteData & 0x20 )? byteValue + 0x20 :
(byteData & 0x10 )? byteValue + 0x40 :
byteData = (byteData & 0x08 )? byteValue + 0x80 :

byteData = ( byteGPIO1X & 0x10 )? byteData + 0x01 :
( byteGPIO1X & 0x80 )? byteData + 0x02 :
( byteGPIO1X & 0x40 )? byteData + 0x04 :
byteData = ( byteGPIO3X & 0x01 )? byteData + 0x08 :

byteData = ( byteGPIO3X & 0x02 )? byteData + 0x10 :
byteGPIO3X & 0x04 )? byteData + 0x20 :

)? byteData + 0x40 :
byteData = ( byteGPIO1X & 0x20 )? byteData + 0x80 :

byteValue;
byteValue;
byteValue;
byteValue;
byteValue;
byteValue;
byteValue;
byteValue;

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_OUTPUT_DATA byteData);

byteData;
byteData;
byteData;
byteData;

byteData;
byteData;
byteData;
byteData;

Il get value bit by bit

Il write byteData value via GPIO2X output pin

this->Read_Byte(F75111_INTERNAL_ADDR GPIO1X_INPUT_DATA,&byteGPIO1X) ; // Get value from GPIO1X
this->Read_Byte(F75111_INTERNAL_ADDR,GPIO3X_INPUT_DATA &byteGPIO3X) ; // Get value from GPIO3X

/I Mask unuseful value
/I Mask unuseful value

Il Get correct DI value from GPIO1X & GPIO3X

WriteByte(F75111_INTERNAL_ADDR,WDT_TIMER_RANGE ,byteTimer); /I set WatchDog range and timer
WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,WDT_TIMEOUT_FLAG | WDT_ENABLE | WDT_PULSE | WDT_PSWIDTH_100MS);
/I Enable WatchDog, Setting WatchDog configure
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Disable WatchDog

3-11-3 10 Device: F75111 VB6 under Windows

The Sample code source you can download from

Source file: 75111 _VB_v1O0.rar http://tprd.info/lexwiki/findex.php/IO_Device:F75111_VB6
Binary file: 75111_VB_Src.rar

USERNAME & PASSWORD: sf

How to use this Demo Application

< 75111_DEMO VB v1.0 M=

Flease key-in the timer by sec |l

B

| Enable WDT ‘ Dizable wDT ‘

Flease key-in the DO Value by hex !l exp:0xFF = FF

SetDO0 Value C

Fush the Button will show the DI 15 _3% Yalue |l

D

1= Walue
Check DI Value
2 Yalue

A Function - Enable WDT timer ,Key-in the value by seconds then system will reboot after
value which you key-in in left text box !!
B Function - Disable WDT timer ,Push down the button then WDT timer value will be clear !!
C Function - Set DO Value ,Key-in the DO value by hex then push the button !!
D Function - Check DI Value ,The right side two text box will display DI 1X & 2X Value
when you push down the button!!
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SDK Function Introduction

Function EnableWDT

Function EnableWDT (timer As Integer)

' Call Writel2CByte(&H3, &H3)
\ Call Writel2CByte(&H37, timer)
! Call Write|2CByte(&H36, &H73)

End Function

E Function DisableWDT()
| Call Writel2CByte(&H36, &H0)

End Function

Call Writel2CByte(&H23, &HO0)
Call Writel2CByte(&H20, &HFF)
Call Writel2CByte(&H2B, &HFF)
Call Writel2CByte(&H21, dovalue)

End Function

Function CheckDIValue()
Dim GPIO1X As Integer
Dim GPIO3X  As Integer
Dim DI1Xhex As String
Dim DI3Xhex As String

Call ReadI2CByte(&H12, GPIO1X)
Call ReadI2CByte(&H42, GPIO3X)

DI1Xhex = Hex(GPIO1X)
DI3Xhex = Hex(GPIO3X)

Text3.Text = "0Ox" + DI1Xhex
Text4.Text = "0x" + DI3Xhex

End Function

Function SetDOValue(dovalue As Integer)
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3-11-4 10 Device: F75111 under linux

The Sample code source you can download from
Source file: F75111v2.0L .tar.gz http://tprd.info/lexwiki/index.php/I0_Device:F75111_under_linux
Binary file: F75111v2.0LBin.tar.gz
USERNAME & PASSWORD: sf
How to compile source code
1. Compile source code with Code::Blocks
download and install the Code::Block with command "apt-get install codeblocks"
Open an exist project(F75111.cbp) in Code::Blocks, click the compile button
(add an option 'pkg-config --libs gtk+-2.0 gthread-2.0" in "Project->Build Option->
Linker Setting->Other linker option")
2. Compile source code with "make"

l.cd F75111

1.make

1.src/f75111 // execute the binary file

How to use this Demo Application

Customize F75111 Address : 0x [gc '

DIC Test
DIfDO Test { Low) ..o, | 0% |
DI Do Test { High ) .o | D % |

7 6 5 4 3 2 1 0
DO Status Bzl EhiEEk B EEE
DI Status B I N S e R N (N

WDT Test
]
[] Enable Loop Test Install
Uninstall
WDT-Stand BY i
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. Press the "Start" button to test DIO function

. Press the "Enable" button to test WDT function

. Press the "Disable" button to disable WDT

. Check the "Enable Loop" box and press "Enable" to do WDT loop test

g A W N P

. Press "Install" to set the system to autorun this application when booting,
press "Uninstall" to remove this application when booting.
6. If WDT enable, system icon will be blinking.

if there's no disable signal

3,

[ Frs1Twor %——Enablesignal———w/
F

if there's disable signal

\/

Disable signal

p.s.
f75111 send "F75111_SetWDTEnable(BYTE byteTimer)" including a parameter "timer",

if there's no disable signal (F75111_SetWDTDisable()) to stop it before timer countdown to 0, System will reboot.
if there's disable signal received, resent Enable WDT signal, for a loop to prevent from reboot

Introduction
10 function In file SMBus.c

| void SMBusloWrite(BYTE byteOffset BYTE byteData)
{
outb( byteData , m_SMBusMaploAddr + byteOffset);

}
{
DWORD dwAddrVal;

dwAddrVal = inb(m_SMBusMaploAddr + byteOffset);

E BYTE SMBusloRead(BYTE byteOffset) \
' return (BYTE)(dwAddrVal & OXOFF);

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO1X_CONTROL_MODE ,0x00); /Iset GPIO1X to Input function
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO3X_CONTROL_MODE ,0x00); /Iset GPIO3X to Input function
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_CONTROL_MODE ,0xFF); IIset GP102X to Output function

this->Write_Byte(F75111_INTERNAL_ADDR,F75111_CONFIGURATION, 0x03); //Enable WDT OUT function




Set output value

BYTE byteData = 0;

byteData = (byteData & 0x01 )? byteValue + 0x01 : byteValue;

byteData = (byteData & 0x02 )? byteValue + 0x02 : byteValue;

byteData = (byteData & 0x04 )? byteValue + 0x04 : byteValue;

byteData = (byteData & 0x80 )? byteValue + 0x08 : byteValue;

byteData = (byteData & 0x40 )? byteValue + 0x10 : byteValue;

byteData = (byteData & 0x20 )? byteValue + 0x20 : byteValue;

byteData = (byteData & 0x10 )? byteValue + 0x40 : byteValue;

byteData = (byteData & 0x08 )? byteValue + 0x80 : byteValue; Il get value bit by bit

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_OUTPUT_DATA byteData); // write byteData value via GPIO2X output pin

BYTE byteGPIO1X = 0;
BYTE byteGPIO3X =0;
BYTE byteData =0;

this->Read_Byte(F75111_INTERNAL_ADDR,GPIO1X_INPUT_DATA &byteGPIO1X) ; // Get value from GPIO1X
this->Read_Byte(F75111_INTERNAL_ADDR,GPIO3X_INPUT_DATA &byteGPIO3X) ; // Get value from GPIO3X

byteGPIO1X = byteGPIO1X & OxFO; I Mask unuseful value
byteGPIO3X = byteGPIO3X & O0xOF; 1l Mask unuseful value

byteData =
byteData =
byteData =
byteData =

byteGPIO1X & 0x10 )? byteData + 0x01 : byteData;
byteGPIO1X & 0x80 )? byteData + 0x02 : byteData;
byteGPIO1X & 0x40 )? byteData + 0x04 : byteData;
byteGPIO3X & 0x01 )? byteData + 0x08 : byteData;

byteData = ( byteGPIO3X & 0x02 )? byteData + 0x10 : byteData;
byteData = ( byteGPIO3X & 0x04 )? byteData + 0x20 : byteData;
byteData = ( byteGPIO3X & 0x08 )? byteData + 0x40 : byteData;
byteData = ( byteGPIO1X & 0x20 )? byteData + 0x80 : byteData; Il Get correct DI value from GPIO1X & GPIO3X

return byteData;
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Enable WatchDog

WriteByte(F75111_INTERNAL_ADDR,WDT_TIMER_RANGE ,byteTimer); Il set WatchDog range and timer
WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,WDT_TIMEOUT_FLAG | WDT_ENABLE | WDT_PULSE | WDT_PSWIDTH_100MS);
/I Enable WatchDog, Setting WatchDog configure
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3-12 LVDS Interface Connector

e LVDS1 : LVDS interface (2x15 pin 1.25mm wafer)

Note : 1. LVDS interface support 18/24bits two channel .

LVDS1

PIN NO.| Description PIN NO. Description

1 PWM dimming 2 +5V

3 +LCD(5V or 3.3V) 4 +LCD(5V or 3.3V)

5 Channel-1-DATA3+ 6 Channel-0-DATA3+

7 Channel-1-DATA3- 8 Channel-0-DATA3-

9 Channel-0-DATA2+ 10 Channel-0-CLK+

11 Channel-0-DATA2- 12 Channel-0-CLK-

13 GND 14 GND

15 Channel-0-DATAL+ 16 Channel-0-DATAO+

17 Channel-0-DATAL- 18 Channel-0-DATAO-

19 GND 20 GND

21 +LCD(5V or 3.3V) 22 +LCD(5V or 3.3V)

23 Channel-1-DATA2+| 24 Channel-1-CLK+

25 Channel-1-DATA2- 26 Channel-1-CLK-

27 Channel-1-DATA1+| 28 Channel-1-DATAO+

29 Channel-1-DATA1- 30 Channel-1-DATAO-

2.JVL1 : LVDS panel +5V/+3.3V Voltage select

3. LVDS1 PIN 1 for panel backlight active, default Hi or Low by JSD1 jumper setting.

4. Pin 1 back light dimming control. Provided 200Hz / 275Hz / 380Hz / 20KHz / 25KHz
and adjust PWM duty cycle by software program.

e CPP1 : Panel Inverter power (5pin 2.0mm wafer)
PIN NO.

Description
+12V or +5V
GND

PWM dimming
ENBKL (3.3V)
ENBKL (5V)

gl bhlw|N| -

Note : 1. JVP1 Inverter Voltage select
2. CPP1 PIN 3 and LVDS1 PIN1 is same signal. Default active setup by JSD1
3. Pin 3 back light dimming control. Provided 200Hz / 275Hz / 380Hz / 20KHz / 25KHz
and adjust PWM duty cycle by software program.
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3-13 Touch screen device

e CT1 : Touch screen (2x5 pin 2.0mm wafer)

Default use USB interface, can change COM interface By OEM BOM.

e For 8- wire type pin define

PIN NO.| Description PIN NO. Description
1 Bottom 2 Bottom Sense
3 Top Sense 4 Top
5 Right 6 Right Sense
7 Left 8 Left Sense
9 GND 10 KEY

Note : 1. For eight wire type cable Pin 3 and Pin4 need short.
2. Touch controller use USB port 8

e For 4- wire type pin define

PIN NO. | Description PIN NO. Description
1 Bottom 2 N/A
3 N/A 4 Top
5 Right 6 N/A
7 Left 8 N/A
9 GND 10 KEY

Note : 1. For four wire type cable Pin 3 and Pin4 need short.
2. Touch controller use USB port 8

e For 5- wire type pin define

PIN NO. | Description PIN NO. Description
1 UR(H) 2 N/A
3 Sense 4 UL(Y)
5 LR(X) 6 N/A
7 LL(L) 8 N/A
9 GND 10 KEY

Note : 1. Touch controller use USB port 8

CT1

00000
oooon

pinl
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3-14 DC power input

e CPI1 : DC-IN Internal Connector

PIN NO. | Description PIN NO. | Description
1 GND 2 GND
3 NC / CAR_IN_ACC 4 DC-IN

Note : 1. DC in from adapter plug in
2. CPI11 Pin 3 for CPC function use for OEM option

e CPI12 : DC-IN Internal Connector (1 X 4 pin 2.0mm Red Wafer )

PIN NO. Description
1 GND
2 DC-IN
3 DC-IN
4 GND

Note : DC in from adapter plug in

e CPI13 : DC-IN Internal Connector ( Option )
(1 X 5 pin 2.0mm Wafer )

PIN NO.

Description

GND

DC-IN

DC-IN

GND

gl |lw|IN|F

CAR_IN_ACC

Note : 1. DC in from adapter plug in
2. share CPI12 Connector

3-15 DVI-D Connector

e DVI1 : DVI-D connector

= eme

PIN NO. Description PIN NO. Description PIN NO. Description

1 Data 2- 9 Data 1- 17 Data 0-

2 Data 2+ 10 Data 1+ 18 Data 0+
3 GND 11 GND 19 GND

4 NC 12 NC 20 NC

5 NC 13 NC 21 NC

6 I’C-CLK 14 +5V 22 GND

7 FC-DATA 15 GND 23 CLK+

8 NC 16 DVI-DETECT 24 CLK-

*Note : DVI support DVI-D 12Bit only
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3-16 DC Power output
e CPOL1 : +12V/+5V DC voltage output (4pin 2.00mm Black Wafer)

PIN NO. Description
1 +5V
2 GND
3 GND
4 +12V *

*Note : DC in +12V by switch to DC-out voltage +12V,

so DC in need stable +12V input

3-17 Battery Input

e BAT1 : 3V Battery hold 2pin
BAT1 : Battery use Li 3V /220mAh (CR2032)

Note : 1. When board without Adaptor plug in,

this board power RTC consumption about 2.7uA

2. If adaptor always plug in RTC power consumption about 0.1uA

BAT1

3-18 HDMI Connector

¢ HDMI1 : HDMI Connector

PIN NO. Description PIN NO. Description
1 TMDS DATA2+ 2 GND
3 TMDS DATA2- 4 TMDS DATA1+
5 GND 6 TMDS DATA1-
7 TMDS DATAO+ 8 GND
9 TMDS DATAO- 10 TMDS CLK+
11 GND 12 TMDS CLK-
13 NC 14 NC
15 DDC CLK 16 DDC DATA
17 GND 18
19 H.P. Detect

*Note : HDMI support 1.3a Spec




3-19 SATA interface
o SATA1/SATA2 : The two SATA connectors

PIN NO.

Description

GND

DATA TX+

DATA TX-

GND

DATA RX-

DATA RX+

N|jojlalbh|lw|N]E

GND

SATA1 SATA2

Note : 1. SATA1 support SATA 3.0 spec update 6Gb/sec .
2. SATA2 support SATA 2.0 spec update 3Gb/sec .
3. CPOL1 provide SATA HDD power +12V,GND ,+5V

3-20 SSD use at SATA3 channel

Note : 1. On board SSD for OEM option

3-21 SIM Socket

e SIM1 : SIM card socket pin define is follow
ISO 7816-2 smart card standard.

PIN NO. | Description [ PIN NO. | Description
1 Vce 5 GND
2 RST 6 Vpp
3 CLK 7 DATA
4 RUF 8 RUF

Note : 1. MPCEL1 Pin 8, 10,12,14,16 for SIM1 card reader use.
2. MPCE2 Pin 8, 10,12,14,16 for SIM1 card reader use for OEM option
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3-22 Mini card & SIM card

o MPCE1/MPCE2 : Support USB and PCle by one Interface (Mini card socket 52pin)

PIN NO. Description PIN NO. Description
1 NC 2 +3.3V
3 NC 4 GND
5 NC 6 +1.5V
7 NC 8 SIM Power
9 GND 10 SIM Data
11 PCle-CLK- 12 SIM CLK
13 PCle-CLK+ 14 SIM Reset
15 GND 16 SIM RFU
KEY KEY KEY KEY
17 NC 18 GND
19 NC 20 NC
21 GND 22 RST-
23 PCle-RX-/mSATA-RX+ 24 +3.3V
25 PCle-RX+/mSATA-RX- 26 GND
27 GND 28 +1.5V
29 GND 30 SMB-CLK
31 PCle-TX-/mSATA-TX- 32 SMB-DATA
33 PCle-TX+/mSATA-TX+ 34 GND
35 GND 36 USB-DATA-
37 GND 38 USB-DATA+
39 +3.3V 40 GND
41 +3.3V 42 NC
43 NC 44 NC
45 NC 46 NC
47 NC 48 +1.5V
49 NC 50 GND
51 MSATA-Detect 52 +3.3V

Note: 1. MPCE 1 used USB port 9, MPCE2 used USB port 10
2. MPCEL1 Pin 8, 10,12,14,16 for SIM1 card reader use.
3. MPCE2 Pin 8, 10,12,14,16 for SIM1 card reader use for OEM option.
4. Just only MPCE2 pin23, 25, 31, 33 supported mSATA device and PCle device alternatively.
5. Pin51 mSATA / PCle auto detect function
6. MSATA use system SATA port 1

3-23 SODIMM socket

Note : 1.SODIM1 : SO-DIM DDR3 1.5V DRAM Socket

2. Support un-buffer type module

SODIM1
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Chapter 4
Introduction of BIOS

The BIOS is a program located in the Flash Memory on the motherboard.

This program is a bridge between motherboard and operating system.

When you start the computer, the BIOS program gains control.

The BIOS first operates an auto-diagnostic test called POST (Power on Self Test) for all the
necessary hardware, it detects the entire hardware devices and configures the parameters
of the hardware synchronization. After these tasks are completed, BIOS will give control of
the computer back to operating system (OS). Since the BIOS is the only channel for
hardware and software to communicate with, it is the key factor of system stability and of
ensuring your system performance at best.

In the BIOS Setup main menu, you can see several options. We will explain these options
in the following pages. First, let us see the function keys you may use here:

Press <Esc> to quit the BIOS Setup.

Press 1| <——(up, down, left, right) to choose the option you want to confirm or modify.

Press <F10> to save these parameters and to exit the BIOS Setup menu after you complete
the setup of BIOS parameters.

Press Page Up/Page Down or +/- keys to modify the BIOS parameters for the active option.

4-1 Enter Setup

Power on the computer and press <Del> key immediately to enter Setup.

If the message disappears before your respond but you still wish to enter Setup,
restart the system by turning it OFF then ON or pressing the "RESET" button on the
system case. You may also restart the system by simultaneously pressing <Ctrl>,
<Alt> and <Delete> keys.
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4-?2 BIOS Menu Screen

The following diagram show a general BIOS menu screen

Main Advanced Chipset Boot Security Save & Exit Menu Bar

BIOS Vension 31847AW/CW Set the Date. Use Tab

Processor Information to switch between
. Date elements.

Name IlvyBridge

Brand String Intel(R) Celeron(R) C

Frequency 1400 MHz General Help Items

Total Memory 4096 MB (DDR3)

Memory Frequency 1333 MHz

System Date [ Tue 01/15/2013] —«: Select Screen

System Time [19:28:51] T | :Select ltem

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults

F4: Save & Exit
Menu Items Function keys Esc: Exit

Current Setting Value

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

4-3 Function Keys

In the above BIOS Setup main menu of, you can see several options.

We will explain these options step by step in the following pages of this chapter,
but let us first see a short description of the function keys you may use here:

@ Press —— (left, right) to select screen;

@ Press 1| (up, down) to choose, in the main menu, the option you want to confirm or to modify.
@ Press <Enter> to select.

@ Press <+>/<—> keys when you want to modify the BIOS parameters for the active option.

@ [F1]: General help.

@ [F2]: Previous value.

@ [F3]: Optimized defaults.

@ [F4]: Save & Exit.

® Press <Esc> to quit the BIOS Setup.
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4-4 Getting Help

Main Menu

The on-line description of the highlighted setup function is displayed at the top right corner
the screen.

Status Page Setup Menu/ Option Page Setup Menu

Press F1 to pop up a small help window that describes the appropriate keys to use and
the possible selections for the highlighted item. To exit the Help Window, press <Esc>.

4-5 Menu Bars

There are six menu bars on top of BIOS screen:

Main To change system basic configuration
Advanced To change system advanced configuration
Chipset To change chipset configuration

Boot To change boot settings

Security Password settings

Save & Exit Save setting, loading and exit options.
User can press the right or left arrow key on the keyboard to switch from menu bar.
The selected one is highlighted.

4-6 Main
Main Advanced Chipset Boot Security Save & Exit

BIOS Vensio 31847AW/CW Set the Date. Use Tab
Processor Information to switch between
Name IvyBridge Date elements.

Brand String Intel(R) Celeron(R) C

Frequency 1400 MHz

Total Memory 4096 MB (DDR3)

Memory Frequency 1600 MHz

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

System Date [ Tue 01/15/2013 ]
System Time [19:28:51]

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Main menu screen includes some basic system information. Highlight the item and then use
the <+> or <-> and numerical keyboard keys to select the value you want in each item.
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System Date
Set the Date. Please use [Tab] to switch between data elements.

System Time
Set the Time. Please use [Tab] to switch between data elements.

4-7 Advanced
Main Advanced Chipset Boot Security Save & Exit

» PCIl Subsystem Settings PCI, PCI-X and PCI
» ACPI Settings Express Settings.
» S5 RTC Wake Settings
» CPU Configuration
» SATA Configuration
» USB Configuration
» SMART Settings
» F71869 Super IO Configuration —«+ Select Screen
> F71869 H/W Monitor I | : Select ltem

) . Enter: Select
» F81216 Second Super IO Configuration +/-: Change Opt.
» Serial Port Console Redirection F1: General Help
» Network Stack F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
PCIl Subsystem Settings
Please refer section 4-7-1

ACPI Settings
Please refer section 4-7-2

S5 RTC Wake Settings
Please refer section 4-7-3

CPU Configuration
Please refer section 4-7-4

SATA Configuration
Please refer section 4-7-5

USB Configuration
Please refer section 4-7-6
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SMART Settings
Please refer section 4-7-7

F71869 Super IO Configuration
Please refer section 4-7-8

F71869 H/W Monitor
Please refer section 4-7-9

F81216 Second Super IO Configuration
Please refer section 4-7-10

Serial Port Console Redirection
Please refer section 4-7-11

Network Stack
Please refer section 4-7-12

4-7-1 PCI Subsystem Settings
Main Advanced Chipset Boot Security Save & Exit

PCl Common Settings Value to be programmed
PCI Latency Timer [32 PCI Bus Clocks] into PCI Latency
Timer Register.

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

PCI Latency Timer

Use this item to set value to be programmed into PCI latency timer register.

The optional settings are:

32 PCI Bus Clocks,64 PCI Bus Clocks,96 PCI Bus Clocks,128 PCI Bus Clocks,
160 PCI Bus Clocks,192 PCI Bus Clocks,224 PCI Bus Clocks,248 PCI Bus Clocks.
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4-7-2 ACPI Settings
Main Advanced Chipset Boot Security Save & Exit

ACPI Settings Enables or Disables
BIOS ACPI Auto
Enable ACPIAUTO Configuration [ Disabled | Configuration.
—«: Select Screen
Enable Hibernation [ Enabled ] 1 | : Select Item
ACPI Sleep State [ S1 only(CPU Stop C..) ] Enter: Select

+/-: Change Opt.
F1: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit
Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
Enable ACPI Auto Configuration
This item allows you to Enabled/Disabled the Advanced Configuration and
Power Management (ACPI).

Enable Hibernation
This item allows you to Enabled/Disabled the Hibernate feature.

ACPI Sleep State

Select ACPI sleep state the system will enter when the SUSPEND button is pressed.
The optional settings: Suspend Disabled / S1 only(CPU Stop Clock) / S3 only
(Suspend to RAM) / Both S1 and S3 available for OS choose from.

4-7-3 S5 RTC Wake Settings
Main Advanced Chipset Boot Security Save & Exit

Wake system with Fixed Time [ Disabled ] Enable or disable

Wake system with Dynamic Time [ Disabled ] S{Z:ﬁmwv‘r’z;e;gs::rm

System will wake on the
hr :: min :: sec specified

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
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Wake system with Fixed Time
Use this item to Enable or Disable system wake on alarm event. When set as Enabled,

system will wake on the hour/min/sec specified.

Wake system with Dynamic Time
Use this item to Enable or Disable system wake on alarm event. When set as Enabled,
system will wake on the current time + Increase minute(s).

4-7-4 CPU Configuration
Main Advanced Chipset Boot Security Save & Exit

CPU Configuration Number of cores to
enable in each
Intel(R) Celeron(R) CPU 1047UE @ 1.40GHz processor package.
CPU Signature 306a9
Microcode Path 10
Max CPU Speed 1400 MHz
Min CPU Speed 800 MHZ
CPU Speed 1400 MHZ
Processor Cores 2
Intel HT Technology Supported
Intel VT-x Technology Supported
Intel SMX Technology Supported
64-bit Supported
L1 Data Cache 32 KB x 2
L1 Code Cache 32KB x 2 —« Select Screen
L2 Cache 256 KB x 2 J L Seletltem
L3 Cache 2048 KB +/-: Change Opt.
F1: General Help
Active Processor Cores [All] F2: Previous Values
Execute Disable Bit [ Enabled ] F3: Optimized Defaults
Intel Virtualization Technology [ Disabled ] F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Active Processor Cores
Use this item to select number of cores to enable in each processor package.

Execute Disable Bit

XD can prevent certain classes of malicious buffer overflow attacks when combined with a
supporting OS (Windows Server 2003 SP1, Windows XP SP2, SuSE Linux 9.2,

RedHat Enterprise 3 Update 3.)

The optional settings are: Disabled, Enabled.
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Intel Virtualization Technology

When set as Enabled, a VHM can utilize the additional hardware capabilities provided by
Vanderpool Technology.

The optional settings: Enabled, Disabled.

4-7-5 SATA Configuration
Main Advanced Chipset Boot Security Save & Exit

SATA Controller(s) [ Enabled ] Enable or disable
SATA Mode Selection [ IDE] SATA Device.

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
SATA Controller(s)
Use this item to Enable or Disable SATA Device.

SATA Mode Selection
Determine how SATA controller(s) operate.
The optional settings are: IDE Mode, AHCI Mode.

4-7-5-1 SATA Mode Selection - AHCI Mode
Main Advanced Chipset Boot Security Save & Exit

SATA Controller(s) [ Enabled ] Enable or disable
SATA Mode Selection [AHCI] SATA Device.
SATA Controller Speed [ Gen3]

—«—: Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
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SATA Controller Speed
Indicates the maximum speed the SATA controller can support.
The optional settings: Gen1, Gen2, Gen3.

4-7-6 USB Configuration
Main Advanced Chipset Boot Security Save & Exit

USB Configuration Enables Legacy USB
support AUTO option
USB Devices: disables legacy support
1 Keyboard, 2 Mice, 2 Hubs if no USB devices are
connected. Disable
Legacy USB Support [ Enabled ] option will keep USB

devices available only

USB3.0 Support [ Enabled ] for EFI applications.
XHCI Hand-off [ Enabled ]
EHCI Hand-off [ Disabled ]

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Legacy USB Support
Enables Legacy USB support. AUTO option disables legacy support if no USB devices are
connected. Disable option will keep USB devices available only for EF| applications.

USB3.0 Support
Use this item to turn on/off USB3.0 Controller support.
The optional settings are: Enabled, Disabled.

XHCI Hand-off

This is a workaround for OSes without XHCI handoff support. The XHCI ownership change
should be claimed by XHCI driver.
The optional settings are: Enabled, Disabled..

EHCI Hand-off

This is a workaround for OSes without EHCI handoff support. The EHCI ownership change
should be claimed by EHCI driver.
The optional settings are: Enabled, Disabled.
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4-7-7 SMART Settings
Main Advanced Chipset Boot Security Save & Exit

Smart Settings Run SMART Self Test on
all HDDs during POST.

Smart Self Test [ Disabled ]

—«: Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

SMART Self Test
Run Smart Self Test on all HDDs during POST.
The optional settings are: Disabled, Enabled.

4-7-8 F71869 Super 10 Configuration
Main Advanced Chipset Boot Security Save & Exit

F71869 Super |0 Configuration Set Parameters of Serial
Port 0(COMA)
F71869 Super 10 Chip F71869
» Serial Port 1 Configuration —«: Select Screen
» Serial Port 2 Configuration 1 | : Select Item
Power Failure [ Keep last state ] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Serial Port 1 Configuration
Please refer section 4-7-8-1

Serial Port 2 Configuration
Please refer section 4-7-8-1
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Power Failure

This item specifies whether your system will reboot after a power failure or interrupt occurs.
[Keep last state] Restores the system to the status before power failure or interrupt occurred.
[Bypass mode] Restores the system to the bypass mode.

[Always on] Leaves the computer in the power on state.

[Always off] Leaves the computer in the power off state.

4-7-8-1 »Serial Port 1 Configuration & Serial Port 2 Configuration
Main Advanced Chipset Boot Security Save & Exit

Serial Port 1~2 Configuration Enable or Disable Serial
Port (COM)
Serial Port [ Enabled ]
Device Settings 10=3F8h; IRQ=4; —ye: Select Screen
1 | : Select ltem
Change Settings [AUTO] Enter: Select
COM1 422/485 control flow [Disabled] +/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Serial Port
Use this item to enable or disable serial port (COM).
The optional settings are: Enabled, Disabled.

Change Settings

Use this item to select an optimal setting for super 10 device.
The optional settings are:

AUTO

I0=3F8h; IRQ=4;

I0=3F8h; IRQ=3,4,5,6,7,10,11,12;

10=2F8h; IRQ=3,4,5,6,7,10,11,12;

I0=3E8h; IRQ=3,4,5,6,7,10,11,12;

I0=2E8h; IRQ=3,4,5,6,7,10,11,12;

COM 422/485 control flow
Use this item to enable or disable serial port Auto flow (COM).
The optional settings are: Enabled, Disabled.
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4-7-9 F17869 H/W Monitor

F17869 H/W Monitor

Press [Enter] to view PC health status.

This section shows the status of your CPU, Fan, and overall system.
This is only available when there is Hardware Monitor function onboard.

4-7-10 F81216 Second Super IO Configuration
Main Advanced Chipset Boot Security Save & Exit

F81216 Second Super IO Configuration Set Parameters of Serial
Port 3(COMC)
F81216 Second Super IO Chip F81216 SecondIO
» Serial Port 3 Configuration
» Serial Port 4 Configuration —«: Select Screen
» Serial Port 5 Configuration t | : Select Item
» Serial Port 6 Configuration Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Serial Port 3 Configuration
Please refer section 4-7-10-1

Serial Port 4 Configuration
Please refer section 4-7-10-1

Serial Port 5 Configuration
Please refer section 4-7-10-1

Serial Port 6 Configuration
Please refer section 4-7-10-1
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4-7-10-1 Serial Port 3~6 Configuration
Main Advanced Chipset Boot Security Save & Exit

Serial Port 3~6 Configuration Enable or Disable Serial
Port (COM)
Serial Port [ Enabled ]
Device Settings 10=260h; IRQ=11; —«: Select Screen
T | : Select ltem
Change Settings [AUTO] Enter: Select
COM1 422/485 control flow [Disabled] +/- Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Serial Port
Use this item to enable or disable serial port (COM).
The optional settings are: Enabled, Disabled.

Change Settings

Use this item to select an optimal setting for super IO device.
The optional settings are:

AUTO

10=260h; IRQ=11;

10=260h; IRQ=10,11,12;

10=268h; IRQ=10,11,12;

[0=270h; IRQ=10,11,12;

10=278h; IRQ=10,11,12;

COM 422/485 control flow
Use this item to enable or disable serial port Auto flow (COM).
The optional settings are: Enabled, Disabled.
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4-7-11 Serial Port Console Redirection
Main Advanced Chipset Boot Security Save & Exit

Console Redirection [ Disabled ] Console Redirection
» Console Redirection Settings Enable or Disable.

—«: Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Console Redirection
Use this item to enable or disable Console Redirection.
The optional settings are: Enabled, Disabled.

4-7-12 Network Stack
Main Advanced Chipset Boot Security Save & Exit

Network stack [ Disabled Link ] Enable/Disable UEFI
network stack.

—«—: Select Screen

1 | : Select Iltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
Network Stack
Enable/Disable UEFI network stack.
The optional settings are: Disable Link, Enable.
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]
4-8 Chipset
Main  Advanced Chipset Boot Security Save & Exit

» PCH-IO Configuration PCH Parameters

» System Agent (SA) Configuration
—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
PCH-IO Configuration
Please refer section 4-8-1

System Agent (SA) Configuration
Please refer section 4-8-2

4-8-1 » PCH-IO Configuration
Main  Advanced Chipset Boot Security Save & Exit

Intel PCH SKU Name HM76 PCI Express
Intel PCH Rev ID 04/C1 Configuration settings
» PCI Express Configuration —«: Select Screen
» USB Configuration t | : Select Item
» PCH Azalia Configuration Enter: Select
+/-: Change Opt.
Wake on LAN [ Disabled ] F1: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
PCI Express Configuration
Please refer section 4-8-1-1

USB Configuration
Please refer section 4-8-1-2

PCH Azalia Configuration
Please refer section 4-8-1-3

Wake on LAN
Use this item to enable or disable integrated LAN to wake the system.
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4-8-1-1 » PCI Express Configuration
Main  Advanced Chipset Boot Security Save & Exit

PCI Express Configuration PCI Express
Configuration settings
» Mini PCle 1

» Mini PCle 2 —«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Mini PCle 1/2
Please refer section 4-8-1-1-1

4-8-1-1-1 » Mini PCle 1/2
Main  Advanced Chipset Boot Security Save & Exit

PCI Express Root Port 3/4 [ Enabled ] Enable or disable PCI
PCle Speed [ Gen1] Express Unsupported
Request Reporting.

—«: Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

PCI Express Root Port 3/4
Control the PCI Express Root Port.
The optional settings are: Enabled, Disabled.
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PCle Speed
Select PCI Express port speed.
The optional settings are: Auto, Gen1, Gen2.

4-8-1-2 » USB Configuration
Main  Advanced Chipset Boot Security Save & Exit

USB Configuration Enable or disable XHCI
Pre-Boot Driver support.
XHCI Pre-Boot Driver [ Enabled ]
xHCI Mode [ Smart Auto ]
HS Port #1 Switchable [ Enabled ]
HS Port #2 Switchable [ Enabled ]
HS Port #3 Switchable [ Enabled ]
HS Port #4 Switchable [ Enabled ]
xHCI Streams [ Enabled ] — Select Screen
1 | : Select Item
EHCI1 [ Enabled ] Enter: Select
+/-: Change Opt.
EHCI2 [ Enabled ] F1: General Help
F2: Previous Values
USB Ports Per-Port Disable Control [ Disabled ] F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

XHCI Pre-Boot Driver
Use this item to enable or disable XHCI Pre-Boot Driver Support.

xHCI Mode
Mode of operation of xHCI controller.
The optional settings are: Smart Auto, Enabled, Disabled.

HS Port #1 Switchable
HS Port #2 Switchable
HS Port #3 Switchable
HS Port #4 Switchable
Always for HS port switching between xHCI and EHCI. If disabled, port is routed to EHCI.

If HS port is routed to xHCI, the corresponding SS port is enabled.
The optional settings are: Disabled, Enabled.
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xHCI Streams
Use this item to enable or disable xHCI Maximum Primary Stream Array Size.
The optional settings are: Disabled, Enabled.

EHCI1/ EHCI2

Use this item to enable or disable USB EHCI (USB 2.0) support.
One EHCI controller must always be enabled.

The optional settings are: Enabled, Disabled.

USB Port Pre-Port Disable Control
Use this item to control each of the USB ports (0~13) disabling.
The optional settings are: Disabled, Enabled.

4-8-1-3 »PCH Azalia Configuration
Main  Advanced Chipset Boot Security Save & Exit

PCH Azalia Congiguration Control Detection of the
Azalia device.
Azalia [Auto ]
Azalia Internal HDMI Codec [ Enabled ] v Select Screen
Azalia HDMI Codec [ Enabled ]

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Azalia
Use this item to enable, disable or auto control detection of the Azalia device.

Azalia Internal HDMI Codec
Use this item to enable or disable internal HDMI codec for Azalia.

Azalia HDMI Codec
Use this item to enable or disable internal HDMI codec Port for Azalia.
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4-8-2 » System Agent (SA) Configuration
Main Advanced Chipset Boot Security Save & Exit

System Agent Bridge Name IvyBridge Config Graphics Settings.
System Agent RC Version 1.2.0.0

» Graphics Configuration —«: Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Graphics Configuration
Please refer section 4-8-2-1

4-8-2-1 » Graphics Configuration
Main Advanced Chipset Boot Security Save & Exit

Graphics Configuration Select the Aperture Size
IGFX VBIOS Version 2170

IGfx Frequency 350 MHz

Aperture Size [ 256MB ]

DVMT Pre-Allocated [64M ]

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

DVMT Total Gfx Mem [ 256M ]
»LCD Control

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Aperture Size
The optional settings are: 128MB, 256MB, 512MB.
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DVMT Pre-Allocated

Use this item to select DVMT 5.0 pre-allocated (fixed) graphics memory size used by the
internal graphics device.

The optional settings are:
32/64/96/128/160/192/224/256/288/320/352/384/416/448/480/512/1024M

DVMT Total Gfx Mem

Use this item to select DVMT 5.0 total graphics memory size used by the
internal graphics device.

The optional settings are:128M, 256M, MAX

LCD Control
Please refer section 4-8-2-1-1

4-8-2-1-1 »LCD Control
Main  Advanced Chipset Boot Security Save & Exit

Graphics Configuration Select the Video Device
which will be activated
Primary IGFX Boot Display [DVI] during POST. This has
Secondary IGFX Boot Display [LVDS] no effect if external
LCD Panel Type [ 1024x768 LVDS1 ] graphics present.
Panel Color Depth [ 18 Bit] Secondary boot display

selection will appear
based on your selection.
VGA modes will be
supported only on
primary display

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Primary IGFX Boot Display

Select the Video Device which will be activated during POST. This has no effect if external
graphics present. Secondary boot display selection will appear based on your selection.
VGA modes will be supported only on primary display.

The optional settings are: VBIOS Default, CRT, HDMI, LVDS, DVI.
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Secondary IGFX Boot Display
The optional settings are: Disabled, CRT, HDMI, LVDS, DVI.

LCD Panel Type
This item allows you to select the panel resolution

1. VBIOS Default

2. 1024 X 600 LVDS
3. 800 X600 LVDS
4, 1024 X 768 LVDSA1
5. 1280 X 1024 LVDS
6. 1440 X 1050 (RB) LVDS1
7. 1440 X 1050 LVDS2
8. 1600 X 1200 LVDS
9. 1366 X 768 LVDS
10. 1680 X 1050 LVDS
11. 1920 X 1200 LVDS
12. 1440 X 900 LVDS
13. 1600 X 900 LVDS
14. 1024 X 768 LVDS2
15 1280 X 800 LVDS
16. 1920 X 1080 LVDS
17. 2048 X 1536 LVDS

Panel Color Depth
Use this item to select the LFP Panel Color Depth 18Bit or 24Bit.

4-9 Boot
Main  Advanced Chipset Boot Security Save & Exit

Boot Configuration Select the keyboard
Bootup NumLock State [On] NumLock state.
Quiet Boot [ Enabled ]

CSM16 Module Version 07.69

GateA20 Active [ Upon Request ]

—<«: Select Screen
Boot Option Priorities 1 | : Select Item
Enter: Select

» CSM parameters +/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
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Bootup NumLock State
Use this item to select keyboard NumLock State.
The optional settings are: On, Off.

Quiet Boot
The optional settings are: Enabled, Disabled.

Gate A20 Active
UPON REQUEST- GA20 can be disabled using BIOS services.
ALWAYS- do not allow disabling GA20.

CSM parameters
Please refer section 4-9-1

4-9-1 CSM parameters
Main Advanced Chipset Boot Security Save & Exit

Launch CSM [ Always ] This option controls if
Boot option filter [ Legacy only ] CSM will be launched
Launch PXE OpROM policy [ Do not launch ]

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Launch CSM
This option controls if CSM will be launched.
The optional settings are: Always, Never.

Boot option filter
This option controls what devices system can boot to.
The optional settings are: UEFI and Legacy, legacy only, UEFI only.

Launch PXE OpROM policy
This option controls the execution of UEFI and Legacy PXE OpROM.
The optional settings are: Do not launch, UEFI only, Legacy only.
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4-10 Security

Main  Advanced Chipset Boot Security Save & Exit

Password Description

If ONLY the Administrator’s password is set,
then this only limits access to Setup and is
only asked for when entering Setup.

If ONLY the User’s password is set, then this

Set Administrator
Password

Is a power on password and must be entered to
boot or enter Setup. In Setup the User will

have Administrator right.

the password length must be

in the following range:

Minimum length 3
Maximum length

Administrator Password
User Password

—«: Select Screen

1 | : Select ltem
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Administrator Password & User Password

To set up an administrator / User password:

1. Select Administratorr / User Password.
The screen then pops up an Create New Password dialog.

2. Enter your desired password that is no less than 3 characters and
no more than 20 characters.

3. Hit [Enter] key to submit.

4-11 Save & Exit

Main  Advanced Chipset Boot Security Save & Exit

Save Changes and Reset
Restore Defaults

Reset the system after
saving the changes.

Boot Override

—«: Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Save Changes and Reset

This item allows user to reset the system after saving the changes.
Restore Defaults

Use this item to restore load default values for all the setup options.
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Chapter 5
DRIVER INSTALLATION

There is a system installation DVD in the package. This DVD does not only include all the
drivers you need but also some other free application programs and utility programs.

In addition, this DVD also includes an auto detect software telling you which hardware is
installed and which driver is needed so that your system can function properly. We call this
auto detect software SYSTEM INSTALL.

SYSTEM INSTALL Supports Windows XP/

Windows 7/ Windows 8/8.1

Insert the DVD into your DVD-ROM drive and the SYSTEM INSTALL menu should appear
as below. If the menu does not appear, double-click MY COMPUTER and double-click
DVD-ROM drive or click START, click RUN, and type X:\SETUP.EXE

(assuming your DVD-ROM drive is X).

Make your selection from SYSTEM INSTALL menu:

1. Auto Detect Main board and OS to AUTOMATIC DRIVER INSTALLATION menu
2. Browse DVD to view the contents of the DVD

3. Exit to exit SYSTEM INSTALL menu
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AUTOMATIC DRIVER INSTALLATION menu

Ivy Bridge for Window 7 (x64)

INF LAN

VGA

SOUND

Back to previous page

1. INF Install Intel Ivy Bridge chipset driver
2. VGA Install onboard VGA driver

3. SOUND Install VIA HD Audio Codec driver
4. LAN To the LAN driver Readme file
5.COM To the COM driver Readme file

6. USB 3.0 Install Intel USB 3.0 extensible Host Controller driver
Each selection is illustrated below:
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5-1 INF Install Intel Ivy Bridge Chipset Driver

Ivy Bridge for Window 7 (x64)

INF LAN
VGA

SO

Back to previous page

1. At the "AUTOMATIC DRIVER
INSTALLATION menu" screen,
click "INF".

Intel® Chipset Device Software

Intel® Chipset Device Software

‘Welcome to the Setup Program

This setup program will install the Intel® Chipset Device Software onto this computer. Itis
strongly recommended that you exit all programs before confinuing.

< Back Next > I

|

Intel® Instalation Framework

. At the "Intel® Chipset Device Software"
screen, click "Next".

Intel® Chipset Device Software

Intel® Chipset Device Softwa

License Agreement

You must accept all o the terms of the license agreement in arder to continue the setup
program. Do you accept the terms?

INTEL SOFTWARE LICENSE AGREEMENT (OEM { IHV / ISV Distribution & Single User)

Intel® Chipset Device Software

Chipset Device Software
Readme File Information

Refer to the Readme fik below to view the system requirements and instalation informatian.
Press the Page Donn key to view the rest of the fle.

Do not use or load this software and any assodiated materials (collectively, the “Software")
unti you have carefuly read the following terms and conditons. By loading or using the

Software, you agree to the terms of this Agreement. If you do not wish to so agree, do not
install or use the Software.

Please Also Note:

*If you are an Criginal Equipment Manufacturer (OEM), Independent Hardware Vendor
{IHY), or Independent Software Vendor (ISV), this complete LICENSE AGREEMENT applies;

<Back || Yes Mo |

Intel® Installation Framewark

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING, L

e e e e e ke e ke e e e o e ok ek e e ok |

Product: Intel(R) Chipset Device Software (i

|
Release: Production Version b
Version: 9.3.0.1026
Target: Intel(R) 7 Series/C216 Chipset Family
Date: November 02 2012

*
-
*
*
-
e e ok ek o ok okl ok ok ko ko

b

<Back || Next> I

e |

Tntel® Installation Framevork

3. At the "License Agreement" screen,
click "Yes".

. At the "Readme File Information" screen,

click "Next".
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Intel® Chipset Device Software : Intel® Chipset Device Software

Intel® Chipset Device Software

Intel® Chipset Device Software

Setup Progress Setup Is Complete

Please wait while the following setup operstions are performed:
g Setp opet Pes Youmust restart this computer for the changes to take effect. Would you like to restart the
computer now?

Instaling Driver: Intel(R) 7 Series/C216 Chipset Family 2 port Serial ATA Storage Cantroller - 1
Version: 9.3.0.

Instaling Driver: Intel(R) 7 Series/C216 Chipset Family SMBus Host Controller - 1E22

Version: 9.3.0.1025 " Mo, 1 will restart this computer later.
Instaling Driver: Intel(R) 7 Series/C216 Chipset Family USB Enhanced Host Controller - 1226
Version: 9.3.0. By
Instaling Driver: Intel(R) 7 Series/C216 Chipset Family USE Enhanced Host Controller - 1£2D U

@ Yes, T want to restart this computer now.

Version: 9.3.0.1025 Click Finish, then remove any installation media from the drives.

Inkel® Installation Framework Intel® Installation Framewiork.

5. Click "Next" 6. Click "Finish" to restart computer.

NOTE: SYSTEM INSTALL will auto detect file path

For Windows XP 64/32-bit, Windows 7 64/32-bit and windows 8 64/32-bit
XA\drivenNINTELMIVY_SAN\inflinfinst_autol.exe

For Windows 8.1 64/32-bit
X\drivenNINTELAIVY_SAN\InAWINS8.1\Setup.exe
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5-2 VGA Install Intel Ivy Bridge VGA Driver

Intel(R) Graphics Driver Software - InstallShield Wizard

Production Version Releases

Ivy Bridge for Window 7 (x64)

Microsoft Windows™ 7 64
Microsoft Windows* 8 64

INF LAN

Driver Revision: 15.28.12.64.2932

December 19, 2012

VGA

et
-

* NOTE: This document refers to systems containing

e
SOUND = following Intel(R) processors:

-

*  3rd generation Intel(R) Core{TM) i3 processor

*  3rd generation Intel(R) Core(TM) i5 processor

*  3rd generation Intel(R) Core(TM) i5 vPro(TM)

processor

= 3rd generation Intel(R) Core{TM) i7 processor -

Back to previous page

coeck [[Thetz | | canen |

1. At the "AUTOMATIC DRIVER
INSTALLATION menu" screen,
click "VGA".

2. At the "Intel® HD Graphics Driver" screen,
click "Next".

Intel® Installation Framewark Intel® Installation Framewark

) HD Graphics Driver

HD Graphics Driver

Welcome to the Setup Program

License Agreement

This setup program will install the following components: You must accept all of the terms of the license agreement in order to continue the setup
- Intel® HD Graphics Driver program. Do you accept the terms?
- Intel® Display Audio Driver

Itis strongly recommended that you exit all programs before continuing. Click Next to continue.

(INTEL SOFTWARE LICENSE AGREEMENT (OEM / IHV / ISV Distribution & Single User)

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING. B
Do not use or load this software and any associated materials (collectively, the “Software)

luntil you have carefuly read the fallowing terms and conditions. By leading or using the

[ FR HRSAT and rable the Windows Aero deskiop fheme T supported.

Software, you agree to the terms of this Agreement. If you do not wish to so agree, do not
iinstall or use the Software.

Please Also Note:

* If you are an Original Equipment Manufacturer (OEM), Independent Hardware Vendor
(1Y), or Independent Software Vendor (ISV), this complete LICENSE AGREEMENT applies;
* If you are an End-User, then only Exhibit A, the INTEL SOFTWARE LICENSE AGREEMENT,

B

Inkel® Installation Framework.

< Back

Inkeli® Installation Framework

3. At the "Welcome to the Setup Program

4. At the "License Agreement” screen,
" screen, Click “Next”.

Click "Next"
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Intel® HD Graphics Driver Intel® HD Graphics Driver

Readme File Information Setup Progress
Refer to the Readme file below to view the system requirements and installation information. Please wait while the following setup operations are performed:
Creating Process: C:\Windows\system32\egsvr3z.exe -
p Creating Process: C: \Windows\system32\yegsvr3z.exe
Production Version Releases Creating Process: C:\Windows\system32yegsvr32.exe
= Deleting Registry Key: HKLM\SOFTWARE\Intel MediaSDK \Dispatch \iw64-1-1
Microsoft Windows® 7 64 Deleting Registry Key: HKLM\SOFTWARE \Intel MediaSDK \Dispatch \w64-51-1
Microsoft Windows* 8 54 Deleting Registry Key: HKLM\SOFTWARE\Intel MediaSDK \Dispatch \iwg4-2-1
Creating Process: C:\Users\RDS3\AppData\Local {Temp\pft5 12 ~tmp\OpenCL{OCLSetup.exe
Driver Revision: 15.28.12.64.2932 Creating Process: C:\Users\RDS3\AppData\Local \Temp\pfts 12~tmp\ICCS\setuplCCS exe
Copying File: C:\ProgramData \Intel\Intsl(R) Update Manager \updateinfo\38f25456-3d63-4751
December 19, 2012 Copying Fie: C: ProgramDats Intel\intel(R) Update Manager device_proflle templates 36254
Click Next to continue. <
= - 4 m ] r
I <gade | text» | I Cancel ] [ Next>
Intel® Installation Framevork Intel® Installation Framewark

5. At the "Readme File Information” screen, 6. At the "Setup Progress” screen,
Click “Next” Click “Next”.

Intel® Tnstallation Framework EE ==
Intel® HD Graphics Driver :

Setup Is Complete

You must restart this computer for the changes to take effect. Would you like to restart the
computer now?

@) Yes, I want to restart this computer now.
(2) No, I will restart this computer later.

Click Finish, then remove any instalation media from the drives.

Intel@ Installation Framevork ]

‘ Intel® Instaltion Framework

7. Click “Finish” to restart computer

NOTE: SYSTEM INSTALL will auto detect file path

For Windows XP 64bit
X:\drivenNINTEL\IVY_SAN\vga\winxp64\winxp64_145110.exe
For Windows XP 32bit
X:\drivenINTEL\IVY_SAN\vga\winxp\winxp_145110.exe

For Windows 7 64bit and Windows 8 64bit
X:\drivenINTEL\IVY_SAN\vga\ WIN_7_8_64\ win64_152812.exe
For Windows 7 32bit and Windows 8 32bit
X:\drivenINTEL\IVY_SAN\vga\ WIN_7_8_32\ win32_152812.exe
For Windows 8.1 64bit
X:\drivenINTEL\MIVY_SAN\vga\WIN8.1\IVY\x64\ Setup.exe

For Windows 8.1 32bit
X:\drivenINTEL\IVY_SAN\vga\WIN8.1\IVY\x86\Setup.exe
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5-3 SOUND Install Realtek High Definition Audio Driver

Ivy Bridge for Window 7 (x64)

INF LAN

VGA COM

SOUND USB 3.0

1. At the "AUTOMATIC DRIVER 2. Click "Next".
INSTALLATION menu" screen,
click "SOUND".

Il sk Wizand Complets

——
ik [ i

3. Click "Finish" to restart computer

NOTE: SYSTEM INSTALL will auto detect file path

For Windows XP 32/64 bit

X:\drivenNINTEL\IVY_SAN\SOUND\WDM_R270.exe

For Windows 7 32/64 bit and Windows 8 32/64 bit
X:\driveNINTEL\IVY_SAN\SOUND\Vista_Win7_Win8_R270.exe

For Windows 8.1 32bit
X:\driveNINTEL\IVY_SAN\SOUND\Win8.1\32bit_Win7_Win8_Win81_R273.exe
For Windows 8.1 64bit
X:\driveNINTEL\IVY_SAN\SOUND\Win8.1\64bit_Win7_Win8_Win81_R273.exe
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5-4 USB 3.0 Install Intel USB 3.0 extensible Host Controller Driver

Ivy Bridge for Window 7 (x64) (intel
Welcome to the Setup Program

INF LAN

This setup program will install the following components:
« Intel® USB 3.0 eXtensible Host Controller Driver
« Intel® USB 3.0 Hub Driver

VGA COM « Intel®USB 3.0 Host Controller Switch Driver

« Intel® USB 3.0 Moritor

Click Next to continue.
SOuU

Back to previous page

Inkel® Installation Framewark

1. At the "AUTOMATIC DRIVER 2. At the "Intel® USB 3.0 extensible Host
INSTALLATION menu" screen, Controller Driver" screen, Click" Next.
Click "USB 3.0".

License Agreement Readme File Information

You must accept al of the terms of the license agreement in order to continue the setup Refer to the Readme file below to view the system requirements and installation information.
program. Do you accept the terms?

INTEL SOFTWARE LICENSE AGREEMENT (OEM [ IHV / ISV Distribution & Single User) - SEEEE WARNING -
a Do not run this driver’s installer (Setup.exe) from a USE storage |

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING. device {ie. external USB hard drive or USB thumb drive). For proper

Do not use or load this software and any assodated materials {collectively, the "Software”) installation, please copy driver files to a local hard drive folder

until you have carefuly read the following terms and conditions. By loading or using the and run from there.

Software, you agree to the terms of this Agreement. If you do not wish to so agree, do not
install or use the Software

-

Please Also Note: : Production Version Releases
o o St Voncor . s oot AR ACHEEVENT spptes * Marosoft Windows™ 7 i
* If you are an End-User, then only Exhibit A, the INTEL SOFTWARE LICENSE AGREEMENT, ™
[ <pek [ e |[ m | <k || mexi> | [ gened
Intel® Installation Framework. Intel® Installation Framework
3. Atthe "License Agreement” screen, 4. At the "Readme File Information" screen,

Click "Yes". Click "Next".
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@tﬂ. Setup Is Complete @

Yfou must restart this computer for the changes to take effect. Would you lke to restart the

Please wait while the following setup operations are performed:

computer non?
Copying File: C:\Program Files ) USE 3.0 eXtensble Host Controller Driver|A »
i \Program Files (x35) Intel [Intei(R) USB 3.0 eXtensble Host Controller Driver\A
\Program Fies (x85) \Intel\Intel(R) USB 3.0 eXtensble Host Controller Driver A
\Program Fies (x35) Intel Inte(R) USB 3.0 eXtensble Host Controller Driver \A Yes, Twant to restart this computer now.
rogram Files ntel\Intel(R) USB 3.0 eXtensible Host Controller Driver
$$ram Files USE 3.0 eXtensble Host Controller Dnver& Mo, il restart this computer Ister.
\Program Files intel\Intel(R) USB 3.0 eXtensible Host Controler Driver\A
\Program Files intel\Intel(R) USB 3.0 eXtensble Host Controller Driver\A
Copying File: C:\Program Fies ) USB 3.0 eXtensible Host Controller Driver\A Ciick Finish, then remove any installation media from the drives.
Creating Registry Key: HLM\SOFTWARE Micr WSBMoN=

Click Next to continue.
l 3

Inkeli® Installation Framework

Inkel® Installation Framework

5. Click "Next" 6. Click "Finish" to restart computer

NOTE: The path of the file
For Windows 7 32/64-bit
X:\drivenINTEL\IVY_SAN\USB3_O\INTEL\Setup.exe
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5-5 ME Install Intel Management Engine Interface Driver

e fenen  Yuw  felp
bl BE
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1 Computm
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1) Wi s st st dvices

¥ Urvvarsa Sovu um controtin

Management Engine Components

Welcome to the Setup Program

This setup program wil install the Intel® Management Engine Components.

Itis strongly recommended that you exit all programs before continuing. Click Next to continue.

<gack [ hext> | [ concal

Inkel® Installation Framework,

1. Plaese Check Device Manager
"PCI Simple Communications
Controllers”

Setup Progress

Please wait whie the following setup operations are performed:

2. At the "Intel® Management Engine
Components” screen, Click” Next.

Please wait whik the following setup operations are performed:

Copying File: C:\Program Files ntel\Intel(R) USB 3.0 eXtensble Host Controller Driver\A
Copying File: C:\Program Files ntelIntel(R) USB 3.0 eXtensble Host Controller Driver\A
Copying File: C:\Program Files USE 3.0 eXtensble Host Controller Driver\A
Copying File: C:\Program Files ) USB 3.0 eXtensible Host Controller Driver\A
Copying File: C:\Program Files USB 3.0 eXtensble Host Controller Driver\A
Copying File: C:\Program Files ntel\Intel(R) USB 3.0 Xtensible Host Contraller Driver\a
Copying File: C:\Program Files (x86)\Intel\Intel(R) USB 3.0 eXtensble Host Controller Driver\a
Copying File: C:Program Files (x88)\Intel\Intel(R) USB 3.0 eXtensble Host Controller Driver\A
Copying File: C:Program Files (x86)\Intel\Intel(R) USB 3.0 eXtensble Host Controller Driver\A
Creating Registry Key: HKLM\SOFT V JSEIMON-—)
Click Next to continue <
< m L3

Inkel® Installation Framework

Engine Componentsuninstall| »
Engine Componentsninstall)
Components\uninstall)

Copying File: C:Program Files

: C: Program Files Components\ninstally
Copying File: C: Wit \difxapi.dl
Copying File: C:Windows\system32\gifiap.dl

Instaling Driver: Intel(R) Management Engine Interface
Version: 8.0.0.1262
Creating Registry Key: HKLM\SOFTWARE \Intel\AMT\MEIVersion=8.0.0. 1262,52
Copying File: C:\Windows\system32\drivers\IntelMEFWVer. di

Click Next to continue.
gl

Intel® Installation Framework

3. At the "Setup Progress” screen,
Click “Next”.

4. Click “Next”.
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Setup Is Complete

The setup program successfully installed the following components:

- Intel® Management Engine Interface
- Intel® Manageability Engine Firmware Recovery Agent

Click Finish to complete the setup process.

Intel® Installation Framewark
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5. Click “Finish”.

NOTE: The path of the file

For Windows XP 32/64 bit and Windows 7 32/64-bit
X:\driveNINTEL\ME TOOL\MEI-Only Installe\MEISetup.exe

6. Plaese Check Device Manager

"PCI Simple Communications

Controllers”
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5-6 How to update AMI BIOS

Step 1. To run afuwingui.exe then click "Open"

v AFUWINGUT v1.09

Information |Saup I F‘mgressl

System Information ———————
05: Windows 7
Bios Size 2621440 bytes

MainBios Size 1703936 bytes

BootBlock Size: 655360 bytes

NVRAM Size: 262144 bytes

Core Version: 04.06

Project Version:  00.49

Fimware 1D Cle50049

Fimware GUID:  b5c59087feac-4b41-9d80790ba5aal70f
Bios Chip Name: Winbond 25%/Q Series

——————————————————ROM File Information ——————————————
Input Rom File:  Unknown

File Rom 1D: Unknown
File Rom GUID:  Unknown

American
Megatrends

Flash Save Esit I

Step 2. Click the new version BIOS (download from the website)

i, Open
Lockin: | |} CIgs0C |« B e E-
MName ‘ Date modified T
il | C1650C_8M_A3.bin | 9/12/2012552PM Bl

< | [

Fiegame:  [CI650C_SM_A3

Files of type: INI Files (*)
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Step 3. Choose "ProgramAll Blocks" and "Do Not Check ROM ID"
" AF 109
Information  Setup | Progress |
- Block Options. Miscelaneous
.9 [T Pogem A Bocks] [T Do Net Check ROMID
] 8 ¥ Main BIOS Image I~ Check ECVe
E © | | Boot Bock [~ Restart After Programming
TR I~ NVRAM [T Preserve Setur
b= gl I ECHlcH Preseve SMBIS [
|- ME Firmware Block Non Crtical Block
"l lrl I lgntion " AL
'rr Eff i mE3 eFe il
o e b
Qpen | Bash | save | Ea |
T Mescelaneous
:’8 ¥ [Program Al Blocks| [¥ Do Not Check ROM ID
8 ¥ Main BIOS Image I~ Check EL .
': § ¥ Boot Block I Restart After Programming
0= W NVRAM ™ Preserve Set
s %l I EC Bloch Preseve SMBIOS [
ME Femware Block Nen Catical Block
-||" '" I~ gt ra
'" e dfi b ) i
Cis E8 7 e
Open e ] save | B |

Step 5. Click "Exit" and restart computer.

@l .
" Information | Setup [Progress |
r—BIOS Map with ME Block(Each Block is 32K) Legend
| []Read
5 "8 []Erase
'L_‘) 5 [ Program
= = v
25 .
Stage:
’r Dare.
1|F”
f .
FFFFFFFFR
Open I Flazh I Save | I Exit I
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Appendix A: Power Consumption Test

Condition

ltem Spec

CPU Intel Ivy Bridge 1047UE 1.4 Ghz
SDRAM DDR3 1333/ 1GB

Windows 7 / SP1
3D Mark Vantage

Operating System
Test Program

HDD 3.5" SATA Standard HDD
HDD 2.5" SATA Slim Type HDD
Test Result for reference !
, Start up Operation | Shut down In Put
Hard Disk Power off . .

Maximum | Stapble | Maximum | Maximum Voltage
0.06A 3.36A 1.74A 3.22A 2.23A 9V
0.06A 2.38A 1.29A 2.25A 1.68A 12v

Standard HDD 0.06A 1.17A 0.66A 1.14A 0.82A 24V
0.06A 0.9A 0.51A 0.86A 0.63A 32V
0.06A 0.8A 0.47A 0.79A 0.55A 36V

\______________________________ _____________________ __________________ _______________ __________________ _____________ ____________|
0.06A 2.17A 1.22A 2.67A 1.67A 9V
0.06A 1.57A 0.88A 1.88A 1.28A 12v

Slim Type HDD 0.06A 0.78A 0.58A 0.94A 0.65A 24V
0.06A 0.62A 0.38A 0.74A 0.5A 32V
0.06A 0.52A 0.34A 0.66A 0.43A 36V

The power consumption depends on your device choice!
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Appendix B: Resolution list

640 x 480 x (256 / 16bit/32bit)
800 x 600 x (256 / 16bit/32bit)
1024 x 768 x ( 256 / 16bit / 32bit)
1152 x 864 x (256 / 16bit / 32bit )
1280 x 600 x ( 256 / 16bit / 32bit)
1280 x 720 x ( 256 / 16bit / 32bit)
1280 x 768 x ( 256 / 16bit / 32bit)
1280 x 800 x ( 256 / 16bit / 32bit)
1280 x 960 x ( 256 / 16bit / 32bit)
1280 x 1024 x ( 256 / 16bit / 32bit)
1400 x 1050 x ( 256 / 16bit / 32bit)
1440 x 900 x ( 256 / 16bit / 32bit)
1600 x 900 X ( 256 / 16bit / 32bit )
1600 x 1200 x ( 256 / 16bit / 32bit)
1680 x 1050 x ( 256 / 16bit / 32bit)
1920 x 1080 x ( 256 / 16bit / 32bit)

1920 x 1200 x (256 / 16bit / 32bit )
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